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Eclipse Parallel Tools Platform 
(PTP)(PTP)

Material adapted  Eclipse 3.6 (Helios) 
from SC09 tutorial

 Tutorial source 
modules indicated in 

and PTP 4.0 released 
June 23, 2010

 First coordinated modules indicated in 
next slide

 All PTP tutorials 

 First coordinated 
release of Eclipse 
PTP!

posted to
 http://wiki.eclipse.org/ptp

 Primary changes: 

 First release with 
significant 
improvement of  Primary changes: 

restrict scope to 
functions that work 

t l

improvement of 
usability of remote 
capabilities

remotely
3-1Module 3



Topics covered todayTopics covered today

Overview More slides than 
 C/C++/MPI 

development
 R t  b ild

have time 
(certainly!)

 Not all machines are  Remote build
 Remote execution
 Remote debugging

 Not all machines are 
supported equally 
well (unfortunately!)

 Remote debugging
Other features and 

wrap-up

 Please don’t hesitate 
to ask questions –
I’d rather have you I d rather have you 
not get stuck and 
not get as far, rather 
th  tti  t k than getting stuck 
early.. 3-2Module 3



Out of band setupOut of band setup

 Please see your  Verification of 
machine’s 
instructions at

 https://wiki.ncsa.illinois.edu/display/AAG/

correct out of band 
install
 ls –la ~/mpiAASG+Projects

 Need to 
 Copy mpi code to your home 

directory

 ls la ~/mpi
 Java –version
Which mpicc

 Modify environment to have 
suitable version of java and MPI

Machine paths at 
 https://wiki.ncsa.illino

is.edu/display/AAG/A
ASG+Projects

3-3Module 3



Module 3: Working with C/C++  Module 3: Working with C/C++, 
MPI and Remote Machines

Objective
 Learn how to use Eclipse to develop C programs
 Learn how to develop  build and launch  and debug an  Learn how to develop, build and launch, and debug an 

MPI program on a remote parallel machine
 Contents

 Brief introduction to the C/C++ Development Tools 
(CDT)

 Create a simple application
 Remote project setup
Working with resource managers
 Launching a parallel application Launching a parallel application
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Workbench
 A Workbench contains perspectives
 A Perspective contains views and editors A Perspective contains views and editors

 The Workbench represents 
th  d kt  d l t 

view
view

the desktop development 
environment
 Contains a set of tools 

for resource mgmt view

editor
for resource mgmt

 Provides a common way 
of navigating through 
the resources

view

the resources
 Multiple workbenches 

can be opened at the 
same time

perspective
Module 3

sa e t e
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PerspectivesPerspectives

 Perspectives define the layout of views in the 
Workbench

 They are task oriented, i.e. they contain 
specific views for doing certain tasks:specific views for doing certain tasks:
 There is a Resource Perspective for manipulating 

resources
C/C f l l d d C/C++ Perspective for manipulating compiled code 

 Debug Perspective for debugging applications
 You can easily switch between perspectives You can easily switch between perspectives
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Switch to C/C++ Perspective/ p
Only needed if 

you’re not you re not 
already in the 
perspective

What Perspective
am in in?
See Title Bar
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Switching PerspectivesSwitching Perspectives

 You can switch  You can switch 
Perspectives by:
 Choosing the 

WindowOpen WindowOpen 
Perspective menu 
option

 Clicking on the g
Open Perspective
button

 Clicking on a 
ti  h t t perspective shortcut 

button
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ViewsViews

 The workbench window is 

view

view viewdivided up into Views
 The main purpose of a view is:

 To provide alternative ways of presenting information

view view

 To provide alternative ways of presenting information
 For navigation
 For editing and modifying information 

 Views can have their own menus and toolbars
 Items available in menus and toolbars are 

available only in that viewavailable only in that view
Menu actions only 

apply to the view
 Views can be resized Views can be resized
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Stacked Views

 Stacked views appear as tabs
S l b b h h Selecting a tab brings that view to the 
foreground
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Helpp

 Access help
 H l H l  C t t HelpHelp Contents
 HelpSearch
 HelpDynamic Help

 Help Contents provides p p
detailed help on different 
Eclipse features

 Search allows you to 
search for help locally  or search for help locally, or 
using Google or the Eclipse 
web site

 Dynamic Help shows help 
related to the current related to the current 
context (perspective, view, 
etc.)
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PreferencesPreferences
 Eclipse Preferences allow customization of almost everything

Open 
i d fWindowPreferences…

C/C++ preferences allow many
options

 Code formatting
settings 

(“Code Style”)
shown hereshown here
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Creating a C/C++ ApplicationCreating a C/C++ Application

Steps:
 Create a new C project
 Edit source code
 Save and build
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Creating a C/C++ ApplicationCreating a C/C++ Application

Steps:
Note: the next several slides will 
illustrate some local 

 Create a new C project
 Edit source code

development concepts.  While 
local development is not the 
focus of this mini-tutorial, we will 

 Save and build use what we learn to help with 
remote development
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New C Project WizardNew C Project Wizard
Create a new C project
 Fil N C P j t FileNewC Project

(see prev. slide)
 Name the project   

‘MyHelloProject’ MyHelloProject  
 Under Project types, under 

Executable,  select Hello 
World ANSI C Project

This  is a 
“Managed Build”
project(no makefile req’d)

and hit Next
 On Basic Settings page, 

fill in information for your 

project

Makefile project;
provide your 

fill in information for your 
new project (Author 
name etc.) and hit Finish

own makefile

Module 3 3-15



Changing the C/C++ Build
S i  M ll

 Open the project properties 

Settings Manually

by right-mouse clicking on 
project and select 
Properties 

 Open C/C++ Build
 Select Settings
 Select C Compiler to change p g

compiler settings
 Select C Linker to change 

linker settingsg
 It’s also possible to change 

compiler/linker arguments
 Hit OK to close Hit OK to close
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Editor and Outline ViewEditor and Outline View
 Double-click on 

source file in the source file in the 
Project Explorer
to open C editor

 Outline view is 
shown for file in 
editor

 We’ll describe the
editor in the 
next few slides…
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Project Explorer Viewj p

 Represents user’s data
 It is a set of user defined 

resources
 Files Files
 Folders
 Projects
Collections of files and Collections of files and 

folders
Plus meta-data

 R   i ibl  i   Resources are visible in 
the Project Explorer View
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EditorsEditors
 An editor for a resource (e.g. a file) 

opens when you double click on 

editor

opens when you double-click on 
a resource

 The type of editor depends on the type of the resource
 c files are opened with the C/C++ editor .c files are opened with the C/C++ editor
 Some editors do not just edit raw text

 When an editor opens on a resource, it stays open across 
different perspectivesp p

 An active editor contains menus and toolbars specific to that 
editor

 When you change a resource, an asterisk on the editor’s title y g
bar indicates unsaved changes

 How to Save
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Source Code EditorsSource Code Editors

 A source code editor is a 
special type of editor for 
manipulating source 
code

f Language features are 
highlighted

 Marker bars for showing
 Breakpoints
 Errors/warnings
 Task Tags, Bookmarks

 Location bar for 
navigating to interesting 
features in the entire file Icons:Icons:
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Content AssistContent Assist

 Type an incomplete function name e.g. ”get" into the editor, yp p g g ,
and hit ctrl-space 

 Select desired completion value with cursor or mouse

 Hover over a program  Hover over a program 
element in the source file to 
see additional information
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BuildBuild

 Your program should build when created.
 To rebuild, many ways include:

 Select project, Hit hammer icon in toolbar
 Select project  Project  Build Project Select project, Project  Build Project
 Right mouse on project, Clean Project
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Build (2)Build (2)

 See the results of the build in the Console View
 Executable should

be in Debug folder:
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Preparation for Remote C/C++ 
P jProject

 General notes:  There are “out of 
b d”    This has been tested 

and found to work on 
the following 

band” setup steps 
that you need to do 
prior to starting the 
tutorialmachines: Queenbee

 The example shown 
is worked on 

tutorial
Copy sample MPI 

code to your 
directoryis worked on 

Queenbee
directory

Set up environment 
on remote machine

 Please refer to setup  Please refer to setup 
instructions for your 
machine
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Remote C/C++ ProjectRemote C/C++ Project

While in the C/C++ 
perspective:
 Right click in the 

Project Explorerj p
 Select New > 

Remote C/C++ 
Projectj
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Remote Project WizardRemote Project Wizard

 This starts the New 
Remote Project 
Wizard
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Remote Project WizardRemote Project Wizard

 This starts the New 
Remote Project 
Wizard

 Name the project Name the project
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Remote Project WizardRemote Project Wizard

 This starts the New 
Remote Project 
Wizard

 Name the project Name the project
 Select Remote 

Tools as the Remote 
Provider

 Select New…
ConnectionConnection
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New Remote ConnectionNew Remote Connection

 Remote Host 
Configuration
 Name the remote 

target g
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New Remote ConnectionNew Remote Connection

 Remote Host 
Configuration
 Name the remote 

target g
 Select Remote Host, 

and fill in the 
hostname
Use the host you 

were assigned
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New Remote ConnectionNew Remote Connection

 Remote Host 
Configuration
 Name the remote 

target g
 Select Remote Host, 

and fill in the 
hostname
Use the host you 

were assigned
 And add in your y

username and 
password (this is 
currently not editable 
once saved)
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Finish Remote SetupFinish Remote Setup

 Choose new remote 
connection
 Then select Browse

to choose one’s 
working directory
 N.B. this is conceptually 

similar to “importing” 
e isting code into a existing code into a 
project, note that you 
can also create an 
empty directory and 
start coding away!start coding away!
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Finish Remote SetupFinish Remote Setup

 Choose new remote 
connection
 Then select Browse

to choose one’s 
working directory
 N.B. this is conceptually 

similar to “importing” 
e isting code into a existing code into a 
project, note that you 
can also create an 
empty directory and 
start coding away!start coding away!

 Choose the mpi
sample code 
directory  and then directory, and then 
select OK
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Finish Remote SetupFinish Remote Setup

We’ll step through 
the rest of the 
wizard to finish the 
remote projectremote project
 Select Next
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Finish Remote SetupFinish Remote Setup

We’ll step through 
the rest of the 
wizard to finish the 
remote projectremote project
 Select Next
 And Next
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Finish Remote SetupFinish Remote Setup

We’ll step through 
the rest of the 
wizard to finish the 
remote projectremote project
 Select Next
 And Next
 A d Fi i h And Finish
N.B. We’ll be 

creating a new 
i  service 

configuration
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Finish Remote SetupFinish Remote Setup

We’ll step through 
the rest of the 
wizard to finish the 
remote projectremote project
 Select Next
 And Next
 A d Fi i h And Finish
N.B. We’ll be 

creating a new 
i  service 

configuration
 Select OK to override 

existing project settingsexisting project settings
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Remote C/C++ ProjectRemote C/C++ Project

 If prompted to 
switch to the Remote 
C/C++ perspective, 
select OK.select OK.
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Remote C/C++ ProjectRemote C/C++ Project

 If prompted to 
switch to the Remote 
C/C++ perspective, 
select OK.select OK.
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Remote C/C++ ProjectRemote C/C++ Project

 If prompted to 
switch to the Remote 
C/C++ perspective, 
select OK.select OK.
 Note that there is an 

issue with the ring.c 
sourcesource
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Remote C/C++ ProjectRemote C/C++ Project

 If prompted to 
switch to the Remote 
C/C++ perspective, 
select OK.select OK.
 Note that there is an 

issue with the ring.c 
sourcesource

 Double click on ring.c
to load it into the 
editor  to see if we editor, to see if we 
can determine the 
issue
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Ring.cRing.c

 Note the 
h d  fil  header files 
marked in red
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Ring.cRing.c

 Note the 
h d  fil  header files 
marked in red

 Also, note that 
th  t  the remote 
indexer has 
produced a 
source outlinesource outline
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ring.cring.c

 Note the 
h d  fil  header files 
marked in red

 Also, note that 
th  t  the remote 
indexer has 
produced a 
source outlinesource outline

 We need to 
amend the 
include paths include paths 
for this 
project…
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Include pathsInclude paths

 Right click on project 
name, then select 
Properties
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Project propertiesProject properties

Open Remote 
Development,
 Select Remote Paths 

and Symbolsy
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Project propertiesProject properties

Open Remote 
Development,
 Select Remote Paths 

and Symbolsy
 Click Add
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Remote Include DirectoryRemote Include Directory

 Add /usr/include for 
queenbee 
 Note to check “add to 

all configurations” and g
“add to all languages

 Hit OK
 Include paths for all  Include paths for all 

other machines are 
in the machine 
instructions
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Remote Include DirectoryRemote Include Directory

 Add /usr/include for 
queenbee 
 Note to check “add to 

all configurations” and g
“add to all languages

 Hit OK
 Repeat for MPI  Repeat for MPI 

includes…
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Remote include pathsRemote include paths

 And you have the 
paths you need for 
your platform
 Note that the details  Note that the details 

differ by platform
 Press “OK” to finalize 

the changesthe changes
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Remote include pathsRemote include paths

 And you have the 
paths you need for 
your platform
 Note that the details  Note that the details 

differ by platform
 Press “OK” to finalize 

the changesthe changes
 Allow Eclipse to 

rebuild the index by 
pressing “Yes”
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Include path issues resolvedInclude path issues resolved

 Verify that include 
paths are now 
resolved
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Include path issues resolvedInclude path issues resolved

 Verify that include 
paths are now 
resolved

 Also note the outline  Also note the outline 
view 
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Follow an include pathFollow an include path…

 Right-click on mpi.h, 
and select Open 
Declaration
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Following declarationsFollowing declarations

 And you can see the 
contents of mpi.h on 
your system
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Following declarationsFollowing declarations

 And you can see the 
contents of mpi.h on 
your system

Note outline view
changed as well
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Building your codeBuilding your code

 Let’s start our build 
by doing a clean 
build
 Project>Clean Project>Clean…
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Building your codeBuilding your code

 Let’s start our build 
by doing a clean 
build
 Project>Clean Project>Clean…
 Select the project we 

are working on (and 
the clean projects the clean projects 
selected below 
button)

 Press OK Press OK
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Build cleanBuild clean

 Note output from 
compiler/make

3-59Module 3



Build cleanBuild clean

 Note output from 
compiler/make
 Ring, ring.o should 

also appear in your pp y
project
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Build cleanBuild clean

 Note you can refresh 
your project’s file list 
– right click on 
Project Explorer  Project Explorer, 
then Refresh

 You can also refresh 
specific projects, by 
right-clicking on the 
project itselfp j
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Build problems?Build problems?

 If there are problems, see:
Marker on editor line
 Problems view 

 Double-click on
line in Problemsline in Problems
view to go to
location of error
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Build problems? Try itBuild problems? Try it

 Remove a semicolon from a line
in your “Hello World” example

 Save file
 R b ild  Rebuild 
 See the 

Problems view Problems view 
 Double-click on line in 

Problems view to go to
l ti  f location of error

 Fix it and rebuild to 
continuecontinue
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Running your codeRunning your code

 Switch to the parallel 
runtime perspective

Window> Open 
Perspective> Perspective> 
Other…
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Running your codeRunning your code

 Switch to the parallel 
runtime perspective

Window> Open 
Perspective> Perspective> 
Other…

 Choose Parallel 
Runtime

 Then press OK
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T i lTerminology

 The PTP Runtime perspective is provided for  The PTP Runtime perspective is provided for 
monitoring and controlling applications

 Some terminology
 Resource manager - Corresponds to an instance of 

a resource management system (e.g. a job 
scheduler). You can have multiple resource mangers 
connected to different machinesconnected to different machines.

Queue - A queue of pending jobs
 Job – A single run of a parallel application
Machine - A parallel computer systemMachine - A parallel computer system
Node - Some form of computational resource
 Process - An execution unit (may be multiple 

threads of execution)

4-66

threads of execution)
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Resource ManagersResource Managers

 PTP uses the term “resource manager” to refer to 
any subsystem that controls the resources required 
for launching a parallel job. 

 Examples: Examples: 
 Job scheduler (e.g. LoadLeveler)
 Open MPI Runtime Environment (ORTE)

 Each resource manager controls one target system
 Resource Managers can be local or remote
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About PTP IconsAbout PTP Icons
 Open using legend icon in 

toolbartoolbar
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PTP Runtime PerspectivePTP Runtime Perspective
Resource 
managers managers 
view

Machines 

Console 
view

view

Node details    
viewview

Jobs viewJobs view
Properties 

view
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Add a resource managerAdd a resource manager

 Right click in 
resource managers 
view, select Add 
Resource Resource 
Manager…
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Add resource managerAdd resource manager

We’ll add 2 resource 
managers for 
queenbee – one for 
OpenMPI  another OpenMPI, another 
for PBS
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Add resource managerAdd resource manager

We’ll add 2 resource 
managers for 
queenbee – one for 
OpenMPI  another OpenMPI, another 
for PBS

 Choose OpenMPI, 
then select Next
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Select Remote 
Tools as the remote 
service provider
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Select Remote 
Tools as the remote 
service provider

 Then select the  Then select the 
appropriate 
connection name
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Select Remote 
Tools as the remote 
service provider

 Then select the  Then select the 
appropriate 
connection name

 Important: be sure 
to click SSH port 
forwarding to forwarding to 
enable ssh tunneling 
of connections back 
t   l tto your laptop
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OpenMPI wizardOpenMPI wizard

 Leave this page as 
default values, select 
next
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OpenMPI wizardOpenMPI wizard

 Leave this page as 
default values, select 
next

Only start resource Only start resource 
manager when you 
need it (leave 
Startup unselected)
 Press Next
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OpenMPI wizardOpenMPI wizard

 Leave this page as 
default values, select 
next

Only start resource Only start resource 
manager when you 
need it (leave 
Startup unselected)
 Press Next

 Add to an existing  Add to an existing 
service configuration
 Select the machine 

we were working on  we were working on, 
then select Finish
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Repeat for the PBS Resource 
MManager

 Right-click in the 
Resource Manager 
view, select Add 
Resource Resource 
Manager… again
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PBS Resource ManagerPBS Resource Manager

 Select PBS Resource 
Manager… then 
Next>
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PBS Resource ManagerPBS Resource Manager

 Select PBS Resource 
Manager… then 
Next>

 Select Remote  Select Remote 
Tools Remote 
Service Provider
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PBS Resource ManagerPBS Resource Manager

 Select PBS Resource 
Manager… then 
Next>

 Select Remote  Select Remote 
Tools Remote 
Service Provider

 And appropriate 
connection name
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PBS Resource ManagerPBS Resource Manager

 Select PBS Resource 
Manager… then 
Next>

 Select Remote  Select Remote 
Tools Remote 
Service Provider

 And appropriate 
connection name

 And enable SSH port  And enable SSH port 
forwarding
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PBS Resource ManagerPBS Resource Manager

 Leave the PBS Batch 
Script Configuration 
as default
 Provides an  Provides an 

opportunity to 
customize resource 
managerg

 Select Next
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PBS Resource ManagerPBS Resource Manager

 Leave the PBS Batch 
Script Configuration 
as default
 Provides an  Provides an 

opportunity to 
customize resource 
managerg

 Select Next
Only start resource 

manager manually
 And select Next
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PBS Resource ManagerPBS Resource Manager

 This time, create a 
new service 
configuration

 And select Finish And select Finish
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Resource managersResource managers

 Voila! We now have 
two resource 
managers
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Resource managersResource managers

 Voila! We now have 
two resource 
managers
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Resource managersResource managers

 Voila! We now have 
two resource 
managers

 To start a resource  To start a resource 
manager – right click 
on the resource 
manager (OpenMPI 
this time), and select 
Start Resource 
Manager
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Note that Resource 
Manager is now 
running (green icon)
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Note that Resource 
Manager is now 
running (green icon)
 Also  queenbee as a  Also, queenbee as a 

system is denoted as 
up and running
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OpenMPI Resource ManagerOpenMPI Resource Manager

 Note that Resource 
Manager is now 
running (green icon)
 Also  queenbee as a  Also, queenbee as a 

system is denoted as 
up and running

 And we have one  And we have one 
head node available 
for interactive use
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Run ConfigurationRun Configuration

 To run our code, 
select Run> Run 
Configurations
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Run ConfigurationRun Configuration

 Sneaky detail –
 Select Parallel 

Application, then
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Run ConfigurationRun Configuration

 Sneaky detail –
 Select Parallel 

Application, then
 Select the New

button
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Run ConfigurationRun Configuration

 Sneaky detail –
 Select Parallel 

Application, then
 Select the New

button
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Run ConfigurationRun Configuration

 Sneaky detail –
 Select Parallel 

Application, then
 Select the New

button
 Now need to setup 

the Resource the Resource 
Manager (pull down 
resource manager 
menu)
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Run ConfigurationRun Configuration

 Sneaky detail –
 Select Parallel 

Application, then
 Select the New

button
 Now need to setup 

the Resource the Resource 
Manager (pull down 
resource manager 
menu)
 Choose OpenMPI
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OpenMPI ConfigurationOpenMPI Configuration

 Note that the 
OpenMPI has both 
basic and advanced 
attributesattributes…
We’ll stick with basic 

for today 
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OpenMPI ConfigurationOpenMPI Configuration

 Note that the 
OpenMPI has both 
basic and advanced 
attributesattributes…
We’ll stick with basic 

for today 
 C fi  2  Configure 2 

processes
 And allocate “by slot”
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OpenMPI ConfigurationOpenMPI Configuration

 Note that the 
OpenMPI has both 
basic and advanced 
attributesattributes…
We’ll stick with basic 

for today 
 C fi  2  Configure 2 

processes
 And allocate “by slot”

 Select the 
Application tab
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OpenMPI ConfigurationOpenMPI Configuration

 Browse for the 
application code
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OpenMPI ConfigurationOpenMPI Configuration

 Browse for the 
application code

 Select the ring 
executable we built executable we built 
previously, then 
press OK
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OpenMPI ConfigurationOpenMPI Configuration

We’ll need to 
configure the 
debugger as well
 Select debugger tab Select debugger tab
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OpenMPI ConfigurationOpenMPI Configuration

We’ll need to 
configure the 
debugger as well
 Select debugger tab Select debugger tab
 Select SDM debugger
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OpenMPI ConfigurationOpenMPI Configuration

We’ll need to 
configure the 
debugger as well
 Select debugger tab Select debugger tab
 Select SDM debugger
 Browse to the location 

of the executablesof the executables
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OpenMPI ConfigurationOpenMPI Configuration

We’ll need to 
configure the 
debugger as well
 Select debugger tab Select debugger tab
 Select SDM debugger
 Browse to the location 

of the executablesof the executables
 Press Apply
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OpenMPI ConfigurationOpenMPI Configuration

We’ll need to 
configure the 
debugger as well
 Select debugger tab Select debugger tab
 Select SDM debugger
 Browse to the location 

of the executablesof the executables
 Press Apply, then 

press Run
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Interactive code runInteractive code run

 Note successful 
completion (refer to 
icons previously)
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Interactive code runInteractive code run

 Note successful 
completion (refer to 
icons previously)
 Code output to  Code output to 

console
 Click on node to get 

process informationprocess information
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Process informationProcess information

 Note information on 
the 2 MPI ranks
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Process informationProcess information

 Note information on 
the 2 MPI ranks
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Process informationProcess information

 Note information on 
the 2 MPI ranks
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Process informationProcess information

 Note information on 
the 2 MPI ranks
 Rank 1
 Rank 1 output Rank 1 output
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Process informationProcess information

 Note information on 
the 2 MPI ranks
 Rank 1
 Rank 1 output Rank 1 output
 Rank 0
 Rank 0 output
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Module 5: Parallel Debugging

Objective
 Learn the basics of debugging parallel programs with 

PTP
 Contents

 Launching a parallel debug session Launching a parallel debug session
 The PTP Debug Perspective
 Controlling individual processes
 P ll l B k i t Parallel Breakpoints
 Terminating processes
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Launching A Debug SessionLaunching A Debug Session
 Use the drop-down next to 

the debug button (bug the debug button (bug 
icon) instead of run button

 Select the project to launch
 The debug launch will use  The debug launch will use 

the same number of 
processes that the normal 
launch used

 First, select Debug 
Configurations… to verify 
the debugger settings
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Verify the Debugger TabVerify the Debugger Tab

 Select Debugger tab
 Make sure SDM is 

selected in the 
Debugger dropdown

 Use the Browse  Use the Browse 
button to select the 
debugger executable 
if required
 If launching remotely   If launching remotely, 

the debugger 
executable must also 
be located remotely

 Debugger session 
dd  h ld t address should not 

need to be changed
 Click on Debug to 

launch the program
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The PTP Debug Perspective (1)
 Parallel Debug

view shows job 

The PTP Debug Perspective (1)

view shows job 
and processes 
being debugged

 Debug view shows g
threads and call 
stack for individual 
processes

 Source view 
shows a current 
line marker for all 
processes
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The PTP Debug Perspective (2)The PTP Debug Perspective (2)

 Breakpoints view
shows breakpoints 
that have been set 
(more on this later)

 Variables view  Variables view 
shows the current 
values of variables 
for the currently y
selected process in 
the Debug view 

 Outline view (from 
CDT) f  CDT) of source 
code
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Stepping All ProcessesStepping All Processes
 The buttons in the 

Parallel Debug ViewParallel Debug View
control groups of 
processes

 Click on the Step Over
buttonbutton

 Observe that all process 
icons change to green, 
then back to yellow

 Notice that the current 
line marker has moved to 
the next source line

Module 5 6-121



Stepping An Individual ProcessStepping An Individual Process
 The buttons in the 

Debug view are used g
to control an 
individual process, in 
this case process 0

 Click the Step Over Click the Step Over
button

 You will now see two 
current line markers, 
the first shows the the first shows the 
position of process 0, 
the second shows the 
positions of processes 
1 31-3

Module 5 6-122



Current Line MarkerCurrent Line Marker

 The current line marker is used to show the 
current location of suspended processes

 In traditional programs, there is a single 
current line marker (the exception to this is current line marker (the exception to this is 
multi-threaded programs) 

 In parallel programs, there is a current line p p g
marker for every process

 The PTP debugger shows one current line 
marker for every group of processes at the marker for every group of processes at the 
same location
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Colors And MarkersColors And Markers
 The highlight color depends on 

the processes suspended at the processes suspended at 
that line:
 Blue: All registered process(es)
 Orange: All unregistered 

process(es)

Multiple processes marker 

process(es)
 Green: Registered or unregistered 

process with no source line (e.g. 
suspended in a library routine)

Multiple processes marker 

Registered process marker

Un registered process marker

 The marker depends on the 
type of process stopped at that 
location

Un-registered process marker
 Hover over marker for more 

details about the processes 
suspend at that location
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Breakpoints
 Apply only to processes in the particular set that is 

active in the Parallel Debug view when the breakpoint 

Breakpoints

active in the Parallel Debug view when the breakpoint 
is created

 Breakpoints are colored depending on the active 
process set and the set the breakpoint applies to:process set and the set the breakpoint applies to:
 Green indicates the breakpoint set is the same 

as the active set.
 Blue indicates some processes in the breakpoint set are 

l  i  th  ti  t (i  th   t  l ) also in the active set (i.e. the process sets overlap) 
 Yellow indicates the breakpoint set is different from the 

active set (i.e. the process sets are disjoint)
 When the job completes  the breakpoints are  When the job completes, the breakpoints are 

automatically removed
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Creating A BreakpointCreating A Breakpoint
 Select the process set that 

the breakpoint should apply p pp y
to, in this case, the workers
set

 Double-click on the left edge 
of an editor window  at the of an editor window, at the 
line on which you want to set 
the breakpoint, or right click 
and use the Parallel 
BreakpointToggle BreakpointToggle 
Breakpoint context menu

 The breakpoint is displayed 
on the marker bar
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Global Breakpoints
 Apply to all processes and all jobs
 U d f  i i  l  d b  

Global Breakpoints

 Used for gaining control at debugger startup
 To create a global breakpoint

 First make sure that no jobs are selected (click in white 
part of jobs view if necessary)part of jobs view if necessary)

 Double-click on the left edge of an editor window
 Note that if a job is selected, the breakpoint will apply to 

the current set
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Terminating A Debug SessionTerminating A Debug Session
 Click on the Terminate

icon in the Parallel icon in the Parallel 
Debug view to 
terminate all processes 
in the active set

 M k   th  R t t  Make sure the Root set 
is active if you want to 
terminate all processes

 You can also use the 
terminate icon in the terminate icon in the 
Debug view to 
terminate the currently 
selected process
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Other CDT featuresOther CDT features

 Searching
Open Declaration / hyperlinking between files 

in the editor
 R  i  fil  (i l  i  dit ) Rename in file (in-place in editor)
 Refactoring

 Rename refactoring / Preview panes Rename refactoring / Preview panes
 Extract Constant refactoring
Other refactorings in CDT
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Language-Based SearchingLanguage Based Searching

 “Knows” what things can 
be declared in each 
language (functions, 
variables, classes, 
modules, etc.)

 E.g., search for every call  E.g., search for every call 
to a function whose name 
starts with “get”

 Search can be project- or 
workspace-wide

3-130Module 3



Open Declaration
N d hi  f  CNeed this for C

 Jumps to the declaration 
of a variable, function, 
etc., even if it’s in a 
diff t fildifferent file

 Right-click on an identifier
 Click Open Declarationp

Tip: Open Declaration works 
in C/C++, and it works in 
Fortran, but it cannot jump 
“across languages”
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Rename RefactoringRename Refactoring
 Changes the name of a variable, function, 

etc  including every useetc., including every use
(change is semantic, not textual, and can be workspace-wide)

Only proceeds if the new name will be legal

In Java (Murphy-Hill et al., ICSE 2008):

(aware of scoping rules, namespaces, etc.)

 Select C/C++ PerspectiveIn Java (Murphy Hill et al., ICSE 2008):
 Open a source file
 Click in editor view on declaration of 

a variable
 Select menu item  Select menu item 

RefactorRename
Or use context menu

 Enter new name
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CDT Rename in FileCDT Rename in File

 Position the caret 
over an identifier.

 Press Ctrl+1
(Command+1 on Mac).

 Enter a new name.  
Changes are 
propagated within 
th  fil    tthe file as you type.
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Module 8: Other Tools and Module 8: Other Tools and 
Wrap-up

Objective
 How to find more information on PTP
 Learn about other tools related to PTP
 See PTP upcoming features

 Contents Contents
 Links to other tools, including performance tools
 Planned features for new versions of PTP
 Additional documentation
 How to get involved
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NCSA
HPC W kb hHPC Workbench

 Tools for NCSA Blue Waters
 http://www.ncsa.illinois.edu/BlueWaters/
 Sustained Petaflop system

 Based on Eclipse and PTP
l d l d l Includes some related tools

 Performance tools
 Scalable debugger
Workflow tools 

(https://wiki.ncsa.uiuc.edu/display/MRDPUB/MRD
+Public+Space+Home+Page)

 Part of the enhanced computational environment  Part of the enhanced computational environment 
described at: 

http://www.ncsa.illinois.edu/BlueWaters/ece.html
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Online InformationOnline Information

 Information about PTP
 Main web site for downloads, documentation, etc.

 http://eclipse.org/ptp
 Developers’ wiki for designs, planning, meetings, etc.

 http://wiki eclipse org/PTP http://wiki.eclipse.org/PTP
 Articles and other documents

 http://wiki.eclipse.org/PTP/articles

 Information about Photran
 Main web site for downloads, documentation, etc.

 http://eclipse.org/photran
 U ’  l User’s manuals

 http://wiki.eclipse.org/PTP/photran/documentation
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Mailing ListsMailing Lists

 PTP Mailing listsg
 Major announcements (new releases, etc.) - low volume

 http://dev.eclipse.org/mailman/listinfo/ptp-announce
 User discussion and queries - medium volume

 http://dev.eclipse.org/mailman/listinfo/ptp-user
 Developer discussions - high volume

 http://dev.eclipse.org/mailman/listinfo/ptp-dev

 Photran Mailing lists
 User discussion and queries

 http://dev.eclipse.org/mailman/listinfo/photran
 Developer discussions –

 http://dev.eclipse.org/mailman/listinfo/photran-dev
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Getting InvolvedGetting Involved

 See http://eclipse.org/ptpp // p g/p p
 Read the developer documentation on the wiki
 Join the mailing lists
 Attend the monthly developer meetings Attend the monthly developer meetings

 Teleconference each second Tuesday, 1:00 pm ET

 PTP will only succeed with your participation!
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